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The SC30 Camera

The SC30 Camera

What is the SC30? The SC30 is a quick, high resolution CMOS color camera used for biomedical
and material sciences applications. It was especially developed for acquisitions
using light microscopy, has a special compact design, and can be connected to

all types of light-microscopes via the C-mount.

Technical data SC30
Chip Type CMOS
Chip Size | Inch 1/2
Effective Area, |mm x mm | 6.55 x 4.92
(H) x (V)
Pixel Size | um x pm 3.2x3.2
Binning Color binning 2x, 3x, 4x
Resolutions
(H) x (V)
at full resolution | pixels 2048 x 1532
Color binning 2x | pixels 1024 x 768
Color binning 3x | pixels 680 x 512
Color binning 4x | pixels 508 x 384
Frame Rate in the resp
resolutions 2
at full resolution | fps 10
Color binning 2x | fps 28
Color binning 3x | fps 37
Color binning 4x | fps 49
Analog to Digital Converter | Bit 10
Exposure times 61 ps - 1745 ms
PC-interface USB 2.0
Camera Mount Standard C-Mount

D Under the following conditions:

Pentium D 3 GHz Hyperthreading, 1 ms exposure time



The SC30 Camera

System To ensure that you can use your SC30 properly, the following system require-
Requirements ments for your PC and your software need to be met:

Hardware / Software

Processor

Intel® Pentium D better than, or equal to, 3.0 GHz
Intel® Xeon (DP / MP)
Intel® Core™Duo SSE2 compatible processor

System memory capacity
(RAM)

512 MB

Hard disk
Removable data media

30 GB hard disk space
DVD-ROM

Monitor

1280 x 1024 resolution with 32-bit video card

Interface

USB 2.0 with Intel®82801DB/DBM USB2 ENHANCED
HOST CONTROLLER

Operating system

Microsoft Windows® XP Professional (32 Bit) SP2
Microsoft Windows ® Vista (32 Bit)

Internet browser

Microsoft Internet Explorer 6.0 or higher

A certain minimum amount of performance will be required of the PC you use to
drive your camera if the speeds specified are to be reached in the live mode. The
hardware recommendations are based on typical systems and processors.
These recommendations can't include all of the systems, resp. hardware combi-

nations, that are possible.



Image Acquisition Software getlT

Image Acquisition Software getlIT

In addition to your camera, you have also received the image acquisition
software getlT. The software offers the basic functions you need to acquire,
view, calibrate, save, load, and print images.

For more complicated tasks, you can connect your camera to a special software
environment for image analysis and management. Olympus offers you a wide
range of imaging system solutions which can be adapted to your individual
needs in many different fields of application in the areas of sciences, industry,
and medicine. They provide you with much more possibilities than getIT as they
enable integrated acquisition, processing, visualization, and analysis of images,
as well as device control, automatization, administration, networking, database
archiving, and the results documentation.

your PC. This is necessary so that the operating system does not install the
wrong TWAIN camera driver. The TWAIN camera driver which is necessary for
using the camera is installed together with the software. See page 13 for more
information about TWAIN.

Warnin Install the image acquisition software getlT before connecting your camera to
g @l g q g gy

Installation of the software including the camera driver

The following step-by-step instructions outline the principles of a generic instal-
lation. You' Il find more detailed step-by-step instructions in the appendix (see
page 41). They apply for any camera. ~

1) Close any and all application programs.

2) Place the installation CD into your computer's CD-ROM drive.
» The setup program will start automatically - unless you have deacti-
vated the autorun function. If so, start the setup.exe file via Windows
Explorer with a doubleclick.

3) An installation wizard guides you through the entire software installation.
Simply follow the onscreen instructions and select the relevant entries. Se-
lect the camera you wish to use.

» The TWAIN camera driver which is necessary for using the camera is
installed together with the software.

4) After you have successfully installed your software, you may now connect
your camera to your PC.
» The camera driver is not signed and therefore not used automatically
under your operating system. So you will have to register the camera
driver with your operating system.

g 5) Doubleclick the getlT program symbol to start the software.

6) Within the image acquisition software click the Set Input button to check to
o see if the camera driver has been integrated successfully into the software.
» Your camera driver has been integrated successfully if the camera is
shown in the Set Input dialog box.
» If your camera does not appear in the Set Input dialog box, click the New
% Channel button. Select your camera from the Available devices list and
click OK. Your camera driver should now be integrated successfully.

Set Input y




Camera and light microscope

7) Click the button with the cross located in the upper right corner of the Set
Input dialog box to close it.

Camera and light microscope

Both the correct camera settings and the correct microscope settings are
essential prerequisites for acquiring high quality images. The most important
rules for the microscope settings are mentioned here; a more thorough expla-
nation to the topic can be found in the appendix.

1) Use ND-filters to reduce the illumination intensity; do not alter the lamp
voltage.

2) Establish Kohler illumination conditions.

3) Select the appropriate total magnification and the objective for the task in
question.

White Balance

Mode of operation

Automatic White
Balance

Separate White
Balance

Microscope settings

When using white balance, the individual color channels are scaled in a way that
the white or neutral gray area of the image displayed on the monitor is displayed
correctly as white or gray. The white balance can be carried out automatically on
each image or manually for individual images.

Select an area on the image that is uniformly gray or white. Such an area
contains an equal intensity of the three color components: red, green and blue.
White balance sets the color channels in such a way that this requirement is
satisfied in the best possible way for the area selected.

White balance is carried out on a part of the image (ROI). Your software alters
the color settings in such a way that the image area in the ROI appears as white,
resp. gray, as possible. After you have once carried out the white balance, you
can reapply it any time, also to a running live-acquisition.

For the automatic white balance, a test image is acquired under optimal illumi-
nation conditions. The individual color channels are then set so that the acqui-
sition also appears white or gray on the monitor. These channel settings are
saved and used automatically for all additional acquisitions.

You carry out a separate white balance on the current image. To do this, you
should select an area in the image which is, for the most part, gray or white.

When you make an acquisitions prior to performing a white balance, your micro-
scope's settings must be the same as those you use in normal practice. This
especially holds true for the filter and the lamp voltage settings. The lamp voltage
of a 12 V halogen lamp should be set to 9 V. It should, however, not be set lower
than 5 V. Use the color neutral ND-filter, should you have to reduce light
intensity.

Appendix |: Microscope settings 37



Camera and light microscope

Monitor Settings for White Balance

Monitor Settings The monitor settings are decisive for the image you see on the monitor. Set your
monitor to the appropriate color temperature, should your device allow this. To
do this, compare the image's color impression on the monitor and in the
eyepiece.

Note The color temperature setting can be altered on most monitors via the monitor
ﬂ | menu buttons located on the monitor. In other cases, the color temperature can
be altered via the operating system.

Changing the color temperature using the operating system

1) Right click on Desktop.
» The Desktop's context menu is opened.

2) Select the entry Properties from the context menu.
» The Display Properties dialog box is opened.

3) Select the Settings tab.

4) Click the Advanced button.

» Another Display Properties dialog box is opened. The appearance and
function of this dialog box depends on the graphics card installed on
your system and your monitor.

» Search for a tab with the name Color or Color Management.

Note The appearance of the operating elements might differ from the one being
ﬂ | described here because the adaptation of the color temperature is not part ofthe ~ ©
operating system, but rather is made accessible by the monitor manufacturer or

the graphics card being used.

5) Select a color temperature whose color impression best corresponds to that
seen in the eyepiece.
» Should your system offer a slide control with the options warm and cold,
do not alter your color temperature with these.

Executing White Balance

Specialized It may be difficult to execute a white balance in some microscopic methods, e.g.
microscopy DIC or polarization. In these cases, execute the white balance using the bright
techniques field method and only then change to the special methods.

Transmitted Light When using the transmitted light method, look for a position through which the
light passes through the cover slip, embedding material, and microscope slide,
but not through the specimen. Should such a position not exist, remove the
sample and carry out the white balance without a sample.

Reflected light When using the reflected light method, you need a reference surface.
Standardized gray cards are best for this. Should one not be available, you can
also use white laboratory porcelain or neutral ND-filter paper. Should your
samples contain very reflective areas, defocus your microscope when setting the
white balance.

White Balance 17



The (GUI) User Interface of getIT

The (GUI) User Interface of getlT

o
-l

GUI

Button bars

Menu bar
Status bar

Image buffer box

Image window

Viewport
Images button bar

Zoom factor

The graphical user interface influences the appearance of a program. It deter-
mines which menus there are, how the individual functions can be called up, how
and where files, e.g., images, are displayed, and much more. This chapter
describes the basic elements of GUI.

The most important commands are linked to a button providing you with quick
and easy access to them.

Some commands can be accessed through the corresponding menu.

The status bar contains the name of the camera and the current zoom factor of
the active image.

Your software assigns an individual image buffer to each image. When you start
up your image acquisition software all available image buffers will be empty.
While working with the program, you fill each individual image buffer by loading
or acquiring images. This means that many images are simultaneously accessi-
ble during any given work session. Only one image buffer however, may be
active at a time.

You can hide the image buffer box to create more room for other windows, for
example: use the [Alt + 2] shortcut.

The image window is a special window which enables you to view all of your
loaded images. It is possible to view up to 9 images simultaneously. To display
them, the image window is divided up into several windows, i.e. viewports. Each
viewport can display a single image.

The image window contains a button bar with which you can quickly alter the
appearance of the images in the image window.

The zoom factor shows you by what percentage you have zoomed the image in
or out.

* An automatic zoom factor is set by default. This means that the zoom factor
is adapted to the current size of the Viewport. Alter the size of the window;
in doing so, the image will be zoomed out so that it can always be viewed
in its entirety. In doing so, the zoom factor will not be greater than 100%.

® You can enter a different zoom factor for each Viewport.

® The current zoom factor will be shown in the Viewport's header.

* When using a zoom factor of 100%, a pixel on the monitor corresponds
exactly to one image pixel.

* Afixed zoom factor does not change when you change the size of the View-
port. Thus, in certain cases, only an image segment will be displayed in the
Viewport.

* As soon as an image is larger than the Viewport, a slide control appears
which enables you to move the image in the Viewport to and fro.

* Move the image directly via Pan&Scroll. Click into the image and keep the
mouse button depressed. If the image is larger than the Viewport, the
pointer changes its form. You now move the image by moving the mouse.



The (GUI) User Interface of getIT
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The (GUI) User Interface of getIT

Press [Ctrl + Alt + T] to
generate a test image.
Among other things, it
shows you the current
monitor resolution.
Press

[Ctrl + Alt + Shift + T] to
generate a color test
image.

The test image is auto-
matically the same size
as the active viewport.
The test image will
always be displayed at
100% zoom.

12
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Optimizing display

1) Use the [Ctrl + Alt + T] shortcut to create a test image.
» The image window contains a button bar with which you can quickly
alter the appearance of the images in the image window.

¥ Images (6). Test (100 %) =] B
HE: D& & (&

Yiewport: 413 %

300 350 400]

2) Click the Arrange Viewports button to redefine the number and arrange-
ment of viewports. Select a 1x2 arrangement.

» Theimage window will be divided up into two viewports. The test image
is in the left viewport. Image buffers will be reassigned. Zoom factors will
be set to Auto. Though reduced in size somewhat, the entire test image
will be shown.

3) Click the Single View button to display just one image in the image window
- the active viewport image.
» The viewport arrangement and what image buffers are shown in which
viewports remain unchanged.
» The Single View button changes to Tile View.

4) Select one of the entries of the Zoom Factor dropdown list - or enter any
zoom factor desired into the field directly; e.g., 30%.

» The testimage will be reduced to 30% zoom. The viewport will no longer

be totally taken up by the image. Where the patterned background
starts (in the viewport) is where the image stops.

5) Click the Zoom In button to double the current zoom factor.
» The test image will now be displayed at a zoom factor of 60%.

6) Click the Adjust Zoom button to have the zoom factor adjusted to fit current
viewport size.
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Acquiring and saving images

* The length/width ratio of the image will not change. Unlike the automatic
zoom factor, the new zoom factor is not linked to the size of a window - i.e.,
even when you adjust the size of a window, the zoom factor stays the same.
Automatic zoom factor is set by selecting the Auto entry from the Zoom Fac-
tor list.

7) Alter the size of the image window.

8) Click the Adjust Zoom to adjust the size of the window to the size of the cur-
rent image (only available for single view).

Acquiring and saving images

TWAIN

Note
9|

=

Set Input

Acquire Image

This chapter describes how you can use your camera and software to acquire
images and to save them to a storage medium. A step-by-step instruction briefly
describes a typical sequence of steps. Afterwards, the commands used with all
of the options will be described in more detail.

The image acquisition is executed with your image acquisition software, via
TWAIN. This abbreviation stands for "Technology Without An Interesting Name".
TWAIN is a standardized software interface between software programs and
image acquisition hardware such as digital cameras or scanners.

Your camera is controlled by a TWAIN driver. This allows you to make image
acquisitions with other application programs which have access to a TWAIN
interface. Examples for this are MS-Word and Adobe Photoshop.

If you are using an imaging system solution provided by Olympus instead of the
image acquisition software sent with your order, your camera will not require the
TWAIN interface. Your camera will then be controlled directly by the correspond-
ing software and entirely incorporated into the respective procedures.

Acquiring, calibrating, and saving images

1) Click the Set Input button to select your camera.
» This step is only necessary if also a scanner is connected to your PC or
if you manage several cameras with your image acquisition software
and would like to choose another camera.

2) In the image buffer box, use your left mouse button to click the image buffer
you would like to use to store your image.
» The selected image buffer will be highlighted in color. If it already con-
tains an image, the next image buffer will be reserved for your image.

3) Click the Acquire Image button to open the TWAIN dialog box.

» The image will be shown live in the TWAIN dialog box.

» Use the live image to optimize the camera settings. Normally you only
have to click the Auto button located in the Exposure time group. Some-
times also a white balance might be necessary.

» Click the Scan button to place the image into the selected image buffer,
thus finalizing the actual image acquisition.

Acquire Image 16
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Acquiring and saving images
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[efine calibration

o

i
Apply calibration

Save A3

Set Input
=

Set Input

The Set Input command
opens the dialog box
with the with the same
name.

4) Click the Define calibration button to determine the calibration data required
for the X/Y calibration of your images.
» This step is only necessary if you would like to carry out a XY calibration
of your images and the required calibration data is not yet available.

5) Click the Apply calibration button.
» This step is only necessary if you would like to calibrate the acquired im-
age.
» You can always calibrate an image at a later time.

6) Click the Save As button to save the image as an image file to a storage
medium.

Click this button to select a camera. This is only necessary when several cam-
eras are available and the wrong camera has been selected.

Your image acquisition software enables you to manage several cameras. Each
camera is assigned to a predefined "logical input channel" within the software -
if the camera driver has been correctly installed. If you want to acquire an image
with a camera, the corresponding input channel must be activated.

Only one input channel can be activated. It will be highlighted in color in the dia-
log box's list and additionally displayed in the lower right part of the program win-
dow's status bar.

IR
0SIS SC30 =]

Twrin D515 5C30
: 0515 Camera PW
TWAN riera Py

=l
Z

Click the New Channel button to create a new input channel for an additional
camera.

Define calibration 20
Apply calibration 23
Save As 24



The New Channel com-
mand opens a dialog
box in which all of the
image sources, that can
be currently selected by
your image acquisition
software, are listed.
Select the desired
image source. To dis-
play all image sources,
click on the plus symbol.

Note
[:]

>

Acquiring and saving images

Seleckt Device E

Available devices: oK. |
= BE TWwWAIN - :
ancel |

You can also use the New Channel button, if you have deleted an input channel
by mistake or if the camera driver has not been integrated successfully into the
software.

Click the Delete Channel, to delete a camera's input channel. You will receive a
message if you really want to do this. If you select Yes, the input channel will be
deleted and the corresponding entry from the Set Input dialog box's list will also
be deleted.

Click the button with the cross located in the upper right corner of the Set Input
dialog box to close it.

GT



Acquiring and saving images

Acquire Image

o

| Acquire Image

This is what the TWAIN
dialog box looks like for
the SC30 camera.

16

Live image

Click this button to open the TWAIN dialog box for the image acquisition.

Before calling up the command, select the image buffer into which the image is
to be stored. If it already contains an image, then the next image buffer will be
reserved for the image.

Description of the TWAIN dialog box

Lz 5€30

Camera:

3

| SC30 Camera #00000001

]

Resolution:

| 2048 1532

]

Expozure time

EaEE
O WE &

=+ =

[ Scan ] [ Cancel

]

You will find your camera’s live image in the left side of the TWAIN dialog box.
The live image enables you to comfortably align, illuminate, and focus on the
object, as well as the possibility to optimally set your camera's settings.

Camera

The Camera field shows you the selected cameras with their serial numbers.

Resolution

The Resolution list enables you to select which XY-resolution is to be used for
acquiring the image. A lower resolution results from combining numerous neigh-
boring pixels ("binning™) or from partially reading out the pixels ("subsampling").
That depends on the camera type. The frame rate is increased both for binning
and for subsampling. In addition the camera is more sensitive for binning. The
SC30 type camera is able to use resolutions of 2048 x 1532, 1024 x 768, 680 x
512 and 508 x 384 pixels, for example.

Exposure time

You can set the exposure time in the Exposure time group.




Exposuretime shorter
than 1 ms

Exposure time longer
than 125 ms

+

Auto

|5,

This is what the Color
Settings dialog box
looks like for the SC30
camera.

Acquiring and saving images

The exposure time required for high-quality acquisitions depends on the illumi-
nation, the properties of the sample, and the camera being used. The exposure
time should be longer than 1 ms and shorter than 125 ms. Should the exposure
time be outside of these limits, you can take the following actions.

The best means of increasing the exposure time is by placing neutral density
filters in your microscope's light path. If no neutral density filters are available,
you should reduce your lamp voltage. But make sure that the voltage of a
halogen lamp doesn't drop to below 5 V. When you have reduced your lamp
voltage you will need to carry out a white balance again.

To reduce the exposure time, first remove any ND-filters that are in use. On the
microscope, you can also additionally set the prism or the phototube's mirror to
"only photo". Should the result still not be adequate, you can then increase the
lamp voltage. After you have increased the lamp voltage, you should carry out
another white balance.

Click the [-] and [+] buttons to change the exposure time in pseudo-logarithmic
intervals. You can also click the arrow buttons next to the display field to alter the
exposure time in linear intervals.

Click the Auto button to automatically set the exposure time.

White Balance

Click the White Balance button to correct a tinge. During a white balance, the
individual color channels for red, green, and blue are set in such a way, that a
white or gray area of an object will be portrayed correctly in white, i.e., gray. All
of the other colors will be shown correctly, as well.

A red rectangle appears in the image. Move it with the mouse to a position as
uniformly white or gray as possible. Change the size of the rectangle by moving
the mouse and simultaneously depressing the mouse button. Rightclick to adopt
position and size of the rectangle and execute the white balance.

Color Settings

Click the Color Settings button to manually alter your camera's color settings.
Based on the type of camera you are using, this may be done via numerous slide
controls.

1.00 1.00 1.00 1.00 0.00 1.00 1.00 “
T =

L3 L

Gamma Saturation Erightness Contrast

Color, Settings g|

L L L
Red Green Blue

White Balance 8

LT



Acquiring and saving images
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Red, Green, Blue The Red, Green and Blue slide controls can be moved from 0,00 to 10,0. The set

Gamma
What is gamma?

Saturation

Brightness

Contrast

Default

ELITIZI

g 8y

Sharpen
Filter On/Off

Sharpen
Filter
Settings

2\

&

value is the factor with which the signals of the corresponding color channel are
multiplied.

Use the Gamma slide control to result in a nonlinear contrast enhancement.

The numerical value of gamma influences how the illumination intensity on the
CCD chip's pixels is converted into the color value of the respective pixels in the
image buffer. Please note that this also applies for the other slide controls. If
gamma equals 1, the conversion from illumination intensity into gray value i.e.,
color value is linear. A nonlinear contrast enhancement is the result if gamma is
not equal to 1. If gamma is less than 1, the light gray values are spread more
than the dark ones. This results in an improvement of contrast in the image's light
areas. The image, in general, will become darker as a whole. If gamma is more
than 1, the dark gray values are spread more than the light ones. This results in
an improvement of contrast in the image's dark areas. The image, in general, will
become lighter as a whole.

Use the Saturation slide control as an alternative to the slide controls of the indi-
vidual color channels. The Saturation slide control enables you to alter the color
reproduction from black and white to a maximum color saturation.

Use the Brightness slide control to change the image's intensity. Values smaller
than 1 lower the image's intensity. Values greater than 1 increase the image's
intensity.
Use the Contrast slide control to change the image's contrast. Values smaller
than 1 lower the image's contrast. Values greater than 1 increase the image's
contrast.

Click the Default button to set all of the slide controls to a predefined default
value.

Auto Contrast

Click the Auto Contrast button, to activate or deactivate the automatic contrast
enhancement. Now the image will always be shown with enhanced contrast
onscreen no matter what the actual exposure conditions are, provided there is
no over exposure. For this purpose, the system automatically calculates two
sensible limits for displaying the intensity from the intensity distribution in the
image. Intensity values below the minimal value and above the maximum values
will be cut off. The intensity values in between will be spread out on the entire
dynamic range of the camera.

Sharpen filter

Use the sharpen filter to increase the sharpness using edge enhancement
already with the live acquisition.

Click the Sharpen Filter On/Off button to activate/deactivate the sharpen filter.
The manner in which the acquired image is affected by the sharpen filter
depends on the sharpen filter parameter. You can adjust this parameter by using
the Sharpen Filter Settings dialog box.

Click on the Sharpen Filter Settings button to open a dialog box where you can
set the sharpen filter parameter:



Scan

Cancel

Acquiring and saving images

Sharpen Filter Settings

Sharpen filker parameter:

off sharp

To adjust the numerical value of the sharpen filter parameter, use the mouse to
move the slide control to the right or left. Whether the contours of the image
appear to be sharper or softer when you apply the sharpen filter, depends on the
position of the Sharpen filter parameter slide control.

Increasing sharpness will accentuate edges, but also brings out more image
noise. Reducing the sharpness makes the image softer. Entering a value of 0 will
result in the sharpen filter having no effect at all.

Please note that when you use the sharpen filter you not only alter the monitor
display, but the actual image information as well. This means that when you are
planning on quantitatively evaluating your images later, you should not use the
sharpen filter. Your software provides you with commands with which you can
subsequently process an image's sharpness at any time.

The Sharpen Filter Settings button is only available if the sharpen filter has been
activated.

Scan

Click the Scan button to place the image into the selected image buffer, thus
finalizing your image acquisition. The TWAIN dialog box closes. You can now
save the image as an image file.

Cancel

Click the Cancel button to close the TWAIN dialog box, without acquiring an
image. Only a black image will appear in the image buffer. As an alternative, you
can cancel an image acquisition by clicking the button with the cross located at
the upper right corner of the TWAIN dialog box.
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Acquiring and saving images

Define calibration

Click this button to determine the calibration data required for the X/Y calibration

of your images. Such a calibration is only necessary and reasonable if you use
Define calibration your camera with a microscope or with a macro stand with one or more definite

magpnification ranges.

The image acquisition software enables you to calibrate images after acquisition.

Calibration means that for each magnification the width and height of an object

area is assigned to the pixel representing that object area. This might be, for

example, 0,63 um x 0,63 um for a magnification of 5x. This calibration data var-

ies for each magnification.

1) Place a stage micrometer under your microscope and focus.

The illustration shows a

light microscope's
micrometer.
|
30 40 50 60 70 80
} ’ ‘ Mouse Cursor |
| Calibration Length = 500 pm | “G
o | I
N
[ Starting Point | [ Final Point
i 2) Click the Acquire Image button to acquire an image of the stage microme-
| Acquire Image ter.

» The image will be put into the active image buffer.

3) Click the Define calibration button to open the dialog box required to deter-
= mine the calibration data.

Defing calibration 4) Click the Calibrate... button.
» The Calibrate Image dialog box opens.



Acquiring and saving images

Calibrate Image

¥ Calibration |

Magnificatior: I'I Lalibrate |

# calibration: I'I pmdP LUnit... |
' calibration: I'I pmdP

®A 1atio; I‘I Iv| Fixed ‘

Calibration
& Arhitrary
" Harizantal

 Vertical

Calibration length: I‘I oo ]

’TI Cancel

3))

6)
7)

8)
9)

10)

11)

Click the Unit... button.
» Select m (for meters) in the Basic unit list in the Set Unit dialog box.

» Select, e.g., 1 in the Scale list if you wish the calibration length to be
shown in um. Confirm by clicking OK.

Enter this magnification level into the Magnification field.

Enter the length you are using to calibrate with into the Calibration length
field.

» The distance between the scale marks 30 and 80 in the example shown
is 500 pm.
Select the Arbitrary option in the Calibration group.

Now click the Calibrate button.
» The mouse pointer will appear within the active image.

Position the mouse pointer at the starting point of the calibration length and
leftclick.

Then position the mouse pointer at the final point of the calibration length

and confirm by leftclicking. The blue line must be the exact same length as

the calibration length you entered in the Calibrate Image dialog box.

» The calibration data for the selected magnification are now shown in the
X calibration and Y calibration fields.

I agnification: |5
% calibration: ID,83 pm/F
¥ calibration: ID,83 pm/F

T¢
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12) Confirm by clicking OK.

>
>

The Calibrate Image dialog box will be closed.

A magnification is now available in the Define Calibration dialog box.
You will be asked whether or not you want to replace the old data with
the new ones, should data about the calibration already exist for this
magnification.

13) Finish the calibration by clicking Close.

>
>

>

>

The calibration will be directly applied to the active image.

You can expand additional calibration data for other magnifications
whenever you like.

To calibrate additional images based on the set calibration data, use the
Apply calibration button.

You can view the calibration data of an image any time, by double click-
ing the image buffer to open the Image Information dialog box.

Description of the dialog box

Define Calibration E2

Camera name: Close | 1/pixel width: =

M agnification:

5
1a

22

Camerajid 1/pixel height: >
Mew |

Delete |

Calibrate. .. |

<< [Graph |

New Click the New button to create a new set of calibration data. This set of calibra-
tion data appears under the selected camera name. This is, for example, useful
if you use your camera on various microscopes.

This is how you create a new set of calibration data:
1) Click the New button.

>

The DCCalib dialog box is opened.

2) Enter a name into the edit field located in the DCCalib dialog box.

w

Please note: The Pixel size linked to image size check box should
always be marked. In this case, the calibration data are automatically
adjusted by the software when setting another image resolution.

Enter a new camera name:
|><c1 0 at =]

v Pisel size linked to image size (Olympus]

Ok I Cancel




Delete
Calibrate...
Graph >>

Acquiring and saving images

3) Confirm by clicking OK.
» A new entry is added to the Camera name list located in the Define
Calibration dialog box. Since there are no calibration data for this
camera, the Magnification list will be empty.

Click the Delete button to delete the active set of calibration data.
Click the Calibrate... button to add new calibration data to the active set.

Click the Graph >> button to show a diagram with the calibration data. Use this
diagram to check your calibration data. The diagram shows the reciprocal pixel
size versus magnification. The points should all be along one line.

Apply calibration

o

fran
Apply calibration

Click this button to calibrate the active image using the available calibration data.
Should there not be any appropriate calibration data available, use the Define
calibration command to create the calibration data, as described starting on
page 20.

1) Acquire an image or click on the image buffer in which the image to be
calibrated has been stored.

2) Click the Apply calibration button.
» The Apply calibration dialog box opens.

Apply Calibration
Camera name: I 0515-Fw-Cameras = I
I agnification: 30 hd

Qg I Cancel |

3) Select the appropriate set of calibration data from the Camera name list.

4) Select the magnification you used to acquire the image from the Magnifica-
tion list.
» Inthe list, you will find all of the magnifications which you defined for this
camera name using the Define calibration command.
» You may also enter a magnification which is not in the list. In this case,
the software automatically interpolates the correct calibration data.

5) Confirm the message by clicking OK.

6) Doubleclick the image buffer to open the Image Information dialog box in
order to view the calibration data.
» The Magnification, Width and Height values have now been accordingly
adapted to the calibration data.
» Only if you save the image in TIF file format, will the calibration data be
saved together with the image.

€c
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Save As
=

Save As

Alternative

Deleting directories
and files

24

Save in
File list

Files of type

File name

Compression

Click this button to save the active image to a storage medium under a new file
name or path name.

Before calling up the command, select the image you would like to save from the
image buffer box.

You can also use the File > Save As... menu command or the [Ctrl + S] shortcut.

You can also additionally use the command to delete directories and document
files. To do so, select the desired files and depress the [Del] key.

Description of the dialog box

Save Image As K ER
Save in: I@ analyS1S getlT j (] |‘=_°F B~

1o
1033
1036
1041
Analpze
Diizplay
todule
B Skir b
] Steel i

Bl wood.ti

Ay Metwark P

File name: Igetl T8 j Save I
j Cancel |

Save as lwpe: ITagged Image Farmat [* tif)

Compression: Mone Options.... |

Select the drive and directory to which the document is to be saved from the
Save in list.

The dialog box shows all the files with the file extension shown in the Save as
type field.

The Save as type list contains all the file formats under which the active image
can be saved. The additional image information including calibration data is only
saved together with the image if you choose the Tagged Image Format (*.1if) file
format.

The File name field offers you a file name. When dealing with newly acquired
images, this would be the image name.

The Compression field provides you with the compression method required to
save images. The field is only shown for the image file formats TIF and JPG
which allow compression. The following compression methods are possible for
the image file format TIF: None, Packed Bits, JPEG 2000, JPEG or LZW.
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You can alter the compression method and quality of the images. To do so,
select either the Tagged Image Format (*.tif), JPEG (JFIF) (*.Jpg) or JPEG 2000
(*.Jp2) file type. Click the Options... button and open the Save Image Options dia-
log box. You will find various compression methods and JPEG quality.

Image Information

Alternative

Image Name

File name

Doubleclick the image buffer to alter the name of the image, to add a comment
to an image, and to display data about the image. Except for the name of the
image this image data are only then saved when you save the image in TIF
format.

Use the [Alt + Enter] shortcut to view data about the image in the active image
buffer.

Image Information E3
General |

Image name: IgetIT_1

Fila name: I

Image buffer; 2 Frame: 1 /1
temory zize: 4185 KB
File size:
Created: 03/04/2008, 12:28
Channel: 0515 Camera P
Magnification: 1 =
Rezolution: 1376 = 1038 x 24
Width: 1.376 Pixel
Height: 1.038 Pixel
Image intensity:

Comment;

Here pou may enter pour comment on the image. ;I

-
ak. I Cancel |

You may enter a new name for the image in the Image name field. It can be up
to 31 signs long.

The image is assigned a standard name during image acquisition, which is com-
piled of the name of the software, as well as a consecutive number.

When you load an image, the File name field will contain that image file's com-
plete path. When acquiring an image using your camera, this field will be blank
- until you have saved the image.

G¢
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Warning ﬁI

Image buffer

Frame: 1/1

Memory size

File size

Created
Channel
Magnification

Resolution

Width
Height

Image intensity
Comment

When saving an image, your software will automatically suggest the image name
for use as the name of the file.

Image name and file name are not the same. If you assign the name "Pollen
04.05.2006 Image 23" to an image, you can save the same in TIF format under
the name "04050623.tif". When you later reload this TIF image, the original
image name will appear within the image buffer.

The Image buffer field displays the number of the image buffer currently contain-
ing the image. This number will of course change when you, for example, put the
image into another image buffer.

The field next to the Image buffer field is not relevant for your image acquisition
software.

To calculate the amount of memory occupied by the image in your RAM, the sys-
tem multiplies the number of image pixels with the current bit depth. The memory
requirements of the image information will also be taken into consideration. For
the RAM memory requirements, it does not matter if the image file has been
compressed on the hard disc or not.

The File size field shows you the file size of a loaded image file. The field is
empty directly after image acquisition.

The Created field shows the acquisition times for images which you acquired
with your camera. For other images, the date and time of the last modifications
made to the image are shown.

The Channel field shows the name of the camera for images acquired with your
camera. The field does not contain any information for other images.

The Magnification field shows the selected magnification for images which you
acquired with your camera. Use the Apply calibration command to define the
magnification.

The magnification for images from other applications is set to 1 as a default.

The Resolution field displays image size (in pixels) and information depth (bits/
pixel). The entry 1376 x 1038 x 24 means: The image width corresponds to
1376 Pixels, the image height corresponds to 1038 Pixel, and the image can
contain 224 different color values.

The Width and Height fields show the absolute measurements of the images
which you have acquired with your camera. These values are determined using
the current image calibration.

For other images, the fields show the width and height of your images in pixels.

The Image intensity field is irrelevant for your camera.

You can enter your annotations about the image in the active image buffer into
the Comment field.
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Additional commands

Open

~u

=
Open

Alternative

Deleting directories
and files

Dialog boxes for loading
files are based on
standard MS Windows
dialog boxes. The dialog
box for loading images
also has a preview
function.

Look in
File list

Files of type

File name

This chapter describes the buttons which have not been described yet in the pre-
vious chapter, as well as the commands which cannot be accessed by a button.

Click this button to load images from a data medium.

Before opening the command, select the image buffer into which the first image
is to be loaded.

You can also use the File > Open... menu command or the [Ctrl + O] shortcut.

You can also additionally use the command to delete directories and document
files. To do so, select the desired files from the corresponding dialog box and
click the [Del] key.

Description of the dialog box

Open Image EH

Loak ir: Iaanal_l,lSIS getl T j el i "|@ o

103
1033
1036
1041
Analyze
Dizplay
Module
B Skinti
- s teel tif
B wood bt

File hame: ISteeI.tif j Open

Filez of type: | Taged Image Format [~ ) i Cancel |

Select the drive and directory of the desired files from the Look in list.

The dialog box shows all of the subdirectories and all files whose format is
displayed in the Files of type field.

You can select the desired document type from the Files of type list. The Tagged
Image Format (*tif) image file format is set by default.

You can also select the Image Formats entry to show a list of all the files with
every image format available. All the displayed images can be opened with your
image acquisition software.

Click the document file you are looking for in the file list, to copy it to the File
name field. You can load several documents simultaneously. To do so, mark a
random selection of files by depressing the [Ctrl] key and clicking on the files you
require.

LZ
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Preview
[

[Del]
Open

~a

=
Open

You can view the single images to the right of the dialog box, thus allowing you
to check which documents you want to open. To do so, click the Preview button
and select the individual image files. The selected document will be displayed in
reduced size.

Click the Preview button a second time to view the file's document properties
with various additional information. When using TIF images, the image attribute
Name gives you the image name, Created the date and time the image was
acquired or created, Resolution the image resolution in height x width (in pixels)
x bit depth, Compression the method of compression, User the name of the user
of the image acquisition software, Application the program version being used,
and Channel the camera with which the image was acquired.

A third click enables you to hide preview.

You can also use the commands of the drop-down menu located to the right of
the button, to switch back and forth between the preview, properties, and stan-
dard view without the preview area.

Use the [Del] key to delete the selected files or directories.
Open enables you to load images into a sequential image buffer.

Loading images stored on the hard drive

1) In the image buffer box, click the image buffer you wish to load the image
into, with the left mouse button. Select - for example - image buffer #5.
» The selected image buffer will be highlighted in color.

2) Click the Open button to load an image.
» The Open Image dialog box will appear.

3) Select Tagged Image Format (*.tif), the standard image format, in the Files
of type list.

» This format is the default when you open this dialog box for the first time.

4) Click the Up One Level button to move up a level in the directory structure
of your computer.
» In the field below the button bar you will find a list of all sub-folders and
documents of the file type selected.

5) Doubleclick on one of the folders listed to get a listing of its contents - i.e.,
all subdirectories and files the folder contains.

6) Click the Preview button to view thumbnails of image files. Select the image
files one at a time.

7) Select the images you wish to load.

8) Click the Open button to load the images selected.

» The Open Image dialog box will be closed.

» The images will be loaded into successive image buffers. You will find
the first image in the active image buffer, e.g., #5. The next images can
be found in image buffers 6-9, if you have simultaneously loaded a total
of 5 images.

» The image type and image name will be shown directly in the image
buffer box. You will, for example, acquire "true-color images" when
using the SC30 camera. A true-color image consists of 224 color values
(24 Bit).
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You can view the r -
] Image || Thumbnail
thumbnails of all of the Number| | Image ‘

loaded images in the L
image buffer box. I
1|

".;?;e

e |

| Image Name|

Using the mouse to drag images into image buffers

= 1) Click the Open button.
Open 2) Leftclick on the image file you wish to load.

3) Drag the file directly onto the desired image buffer, while keeping your left
mouse button depressed, (drag&drop).
» The image buffer will show a thumbnail of the image you have loaded.

4) Repeat the last two steps if you wish to load further images.
5) To quit loading, just click the Close button.
Use the mouse to

drag&drop images into
the image buffer Look in; |_,| Images

6¢

desired. 2

MS Explorer, a file L
manager, can also be [

used for drag&drop

loading.

File name: [auts

Flesofype:  [Tage

Print Directly

Click this button to quickly print a single image. The Print Image dialog box will
= NOT open. The command always prints an image in default page layout: The
Print Directly header shows the image name, the footer shows the date and time of when print-
ing was started. The button is only available if an image has been loaded into the

active image buffer.
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Print Setup...

30

Printer

Name

Status/Type/Where/
Comment

Properties...

Paper
Size/Source

Format
Portrait/Landscape

Use this command from the File menu to determine a certain printer and printer
settings as a default for your image acquisition software.

The selected printer and the corresponding settings remain for future applica-
tions using your image acquisition software.

Print Setup [ 2]

r Printer

Mame: |2DB HF Lasenlet 4050 Senes PS j Properties... |

Status: Bereit

Type: HF Lager)et 4050 Sernes PS
“Where:  \wintraneth20B ps

Comment: Laserprinter HP-4080 Postecript

— Paper Orientation
Size: |A4 j & Poitrait
Source: ITra_l,J 2 j " Landscape

Ok, I Cancel |

From the Printer group, select the Name of the desired printer from the list as
well as the corresponding properties using the Properties... button.

The Name list contains all of the printers installed under Windows. The printer
which has been defined as standard by Windows in the printer settings, is the
default printer. Select the printer which you mostly use with your image acquisi-
tion software from the printer list.

The Status, Type, Where and Comment fields provide information about the
selected printer: operating state, printer type, path name, and additional
comments.

Click the Properties... button to open the dialog box with the same name. This
will allow you to select the printer settings with regards to the configuration,
paper, graphics, and font. The exact appearance of the dialog box depends on
the selected printer and printer driver.

Select the paper size and source from the Paper group.

Select the desired entries from the Size and Source lists. The entries depend on
the printer you are using.

The Format group enables you to determine the page alignment.

Select the Portrait format to print the pages vertically. Select the Landscape
format to print the pages horizontally.



Print...

Printer

Name

Status/Type/Where/
Comment

Properties...

Page layout

Additional commands

Use this command from the File menu to print images.

Print Image EHE
— Frirter
MName: IEDE HF Lazerlet 4050 Series PS j Eroperties... |
Status: Bereit

Type: HF Laserlet 4050 Series PS
Where: “Aintraneth 206 ps
Comment: Lazerprinter HP-4050 Postzeript

— Page layout
ISingIeImage j
— Print image: Frame
* Dizplayed image |2_E ¥ Y4 point -
" Allimages . Cancel |
" Range of images MNumber of copies:
[1-24 =

Use a comma to delimit single image
buffers and a dash to delimit image
buffer ranges, e.g.: 1,3-7.10

From the Printer group, select the Name of the desired printer from the list as
well as the corresponding properties using the Properties... button. These set-
tings are lost after closing the program. Use the Print Setup... command if you
want to set the printer and the corresponding properties as default for your image
acquisition software.

The Name list contains all of the printers installed under Windows. When open-
ing the program, the printer which has been selected as default printer for your
image acquisition software in the Print Setup dialog box, is preset. The printer
selected for the previous prints will be offered for each additional print.

The Status, Type, Where and Comment fields provide information about the
selected printer: operating state, printer type, path name, and additional
comments.

Click the Properties... button to open the dialog box with the same name. This
will allow you to select the printer settings with regards to the configuration,
paper, graphics, and font. The exact appearance of the dialog box depends on
the selected printer and printer driver.

The Page layout list contains the Single Image and Multiple Images entries. Here

you can select which predefined page layout is to be used for printing. The Print
images group enables you to then decide which images will actually be printed.

T€
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Two page layouts are
predefined. Print either
one or six images on a

page.

Each image has its own
header when using
numerous images.

Single Image

Multiple Images

Print images

Displayed image

S\ All images
™ .

Range of images

(Option)

Frame

Number of copies

OK

File list

1 D:A Smageshalgraing. tif
2 D5 AmagesiSkin tif

3 DM SImageshbu-label bif
4 Db S magesiwoood. bf

- AT
AN

AT

Select the Single Image entry when wanting to print one image per page. The
header contains the image name, while the footer contains the date and time of
print.

Select the Multiple Images, to print 6 images on one page, respectively. Each
image then automatically contains a header with the image name.

The Print images group enables you to determine which images you want to
print. The selected images are then printed in the page layout which you selected
from the Page layout list. In doing so, the number of pages printed will automat-
ically refer to the number of images selected. These are, for example, 3 pages,
should you want to print 3 images with the Single Image page layout.

Choose the Displayed image option to only print the image in the active image
buffer.

Select the All images option to print all of the images in the image buffer box.

Select the Range of images option to print a range of images from the image
buffer box. To do so, you enter the number of the image buffers whose images
you would like to print, into the corresponding field. Each number is separated
by a comma. The order of the image buffers in the field corresponds with the
order in which the images are to be printed. This allows you to control the order
of several images on a page. Several consecutive image buffers can be replaced
by an interval. For example, you can write 4-7 instead of 4,5,6,7.

You can enter the width of the frame which is to be displayed around each image
into the Frame field. The unit is a 1/4 point. The setting "0" means that no frame
is to be printed.

You enter the number of copies you would like to have printed into the Number
of copies field.

OK enables you to close the dialog box and start printing.

Use the display of the path names at the end of the File menu to quickly load the
corresponding images.

The most recent images to be saved and loaded are displayed in the file list.
Click the desired file name or type in the corresponding number using your key-
board.

The file name remains even if you exit and restart the program.



Exit
Alternative

Warning ﬁI

Image inthe clipboard

Additional commands

Use the command from the File menu to end the program.

Click the button with the cross located at the upper right edge of the program win-
dow.

Save all of the loaded images you want to keep. Any unsaved images will be
deleted without prior warning.

If you have copied an image into the clipboard, you will get a message informing
you of this - if the image is larger than 768 x 576 x 8 bits. Click on Yes if you wish
to keep the image in the clipboard - it will remain available to you for other appli-
cations.

Any image of smaller size will remain available to you anyway.

Scale Bar, Show in Viewport

Note
[:]

Use this command from the Image menu to display or hide a standard scale bar
in the image window. This setting applies to all loaded images. You will only
attain a useful scale bar after you have calibrated the image by clicking the Apply
calibration button.

The automatic scale bar in the viewport is not part of the image, but rather a
property of the viewport. It appears in a default size in the lower right hand cor-
ner, i.e., the size, position and font size of the scale bar does not change if you
alter the position of the image within the viewport, or if you alter the image's zoom
factor. The calibration length will always be automatically adjusted to fit the cur-
rent zoom factor of the image in the viewport. You may also have the unit auto-
matically adjusted in order to avoid excessively large or small numeric values.

You can alternatively use the keyboard shortcut [Shift + F4] to be able to quickly
switch between views.

Scale Bar, Burn into Image

Warning ﬁI

Select numerous
images
What's it for?

Use this command to irrevocably insert the scale bar into the image. In doing so,
all of the image information below the burned scale bar will be lost.

Please remember that this command cannot be reversed.

A scale bar that has been burned into an image can of course no longer auto-
matically be adjusted to fit image size because it has become a part of that
image.

You can simultaneously apply this command to numerous images. To do so,
select the desired images from the image buffer box.

One of the main reasons for burning a scale bar into an image is when you are
preparing to export an image into another application program - e.g., MS Word -
which cannot read the image’s calibration data. The image calibration remains
accessible, if the scale bar has been burnt into the image. If you want to print an
image together with its scale bar you also have to burn the scale bar into the
image beforehand.

Apply calibration 23

2
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Position and length

Delete Image

Alternative
Why delete images?

Warning ﬁI

Which images will not
be deleted?

Deleting selected
images

Delete all images

The scale bar is burnt into the lower right hand corner. The length of the scale
bar corresponds to the length which is displayed in the viewport when using a
zoom factor of 100%.

Use this command from the Image menu, in order to delete the image from the
active image buffer.

Activate the image buffer and depress the [Esc] key.

Use this command to remove images no longer required. Since the program allo-
cates space for every occupied image buffer, using this command will relieve a
considerable amount of memory. A true-color image with a resolution of 2576 x
1932 pixels requires about 15 megabytes of RAM. MS Windows will then start
swapping memory to disk. If you are using up too much storage your disk will
have to be active more and more often thus slowing down the reaction time of
this and other applications. By deleting images, you can relieve the correspond-
ing amount of memory in the RAM and thus increase the speed of the program.

You will not receive a warning message. The image will be lost if it has not been
saved to the hard disk.

Saved files on the hard disk or other storage mediums are NOT affected.

To delete multiple images all at once, select them in the image buffer box. Press
[Shift] or [Ctrl] while selecting the images with the mouse. Now the command in
the Image menu will be called Delete Images.

If you keep the [Shift] key depressed while opening the Image menu, the com-
mand will be Delete all Images instead of Delete Image. The contents of all buff-
ers will be erased and the allocated memory will become available once again.

Image Manager

Alternative
What's it for?

What will happen...

Status Bar

What will happen...

Use this command from the Window menu to display or hide the image buffer
box.

You can also use the [Alt + 2] keyboard shortcut.

You can hide the image buffer box to increase the size of the document area.
For example, you will have more room on your monitor for the image window
when wanting to display numerous images simultaneously.

The command name is marked by a check mark in front of the command when
the image buffer box is displayed.

Use this command from the \Window menu to display or hide the status bar.

The command name is marked by a check mark in front of the command when
the status bar is displayed.

The (GUI) User Interface of getIT 10
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Standard Button Bar

What will happen...

About...

System Info...
What's it for?

Save Info H |

Use this command from the Window menu to display or hide the standard button
bar.

The command name is marked by a check mark in front of the command when
the standard button bar is displayed.

Use this command from the ? menu to display information about your program
such as: version number, serial number, copyright, as well as system information
pertaining to your computer and your MS Windows installation.

Click the System Info... button to open the dialog box with the same name.

The dialog box contains various lists with information pertaining to your system:
image acquisition software and hardware components such as your camera. It
also contains information about your PC and operating system.

Wl System Info Hi= I

H e E entries
Item | Yalue |
Mame analysIs getlT
&-DLLs \ersion 5.0 (Build 1234}
[ Imaging © Modules Command Line
Directory C:\Program Files\getIT Daily ...
Pragrarn Language English

Windows Wisual Themes  No

Z

Use the tree view located to the left of the dialog box as if it were a table of con-
tents: Click the "+" symbol on the left side to show the "chapter”. Select an entry
to view its contents to the right.

Click the Save Info button to open the standard windows I/O dialog box. You can
then determine a path in which the contents of this dialog box is to be saved in
the "Sysinfo.txt" file. Furthermore, the file "SISgetIT.ini" and additional INI and
LOG files will be saved.

Ge



Additional commands

More Info
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Click the More Info button to open the System information Windows dialog box.
This enables you to take a look at the assembly and configuration of your com-
puter, as well as your operating system's settings and components and the
loaded Microsoft programs.
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Appendix I:
Microscope settings

This illustration clarifies
the basic assembly of
the components of a
microscope in
transmitted-light mode.

Your digital camera can only achieve high image quality if the microscope has
been optimally set. A subsequent correction to the software can never correct
deficiencies in the image resulting from faulty settings made to the camera and
microscope.

The optical system "microscope" offers numerous setting possibilities. In order
to attain best acquisition results, the settings must be made precisely.

In spite of varying models and observation possibilities, the microscope's image
producing components are in accordance with each other.

A microscope basically consists of the optical components, objective and
eyepiece. An additionally important component is the illuminator.

Camera

Objective
— Sample
> Condenser

Illumination

O

llumination

Lamp Selection

Light is a decisive medium for creating images with a microscope. As a result,
the light, i.e. illumination, plays an important role in creating the image in the
microscope.

The goal of the illumination settings is the equal distribution of light on the sample
with parallel light rays falling on the object. The illumination must be bright
enough to make all of the image details visible; however over-illumination leads
to images being too bright and low-contrast. In addition, the color of the light has
a strong impact on the sample's color rendering.

The tungsten-halogen lamps and gas discharge lamps are the most commonly
used lamps in microscopy. The light creating processes of both lamp types are
fundamentally different.

LE
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Tungsten-halogen
lamps

Gas discharge lamp

ND filter

Tungsten-halogen lamps comply with their functionality to a conventional light-
bulb. Electricity flowing through a metal wire heats the wire to the extent that light
is produced (thermal emitter). In doing so, the wire emits a continuous spectrum,
hence a broad spectral band is emitted. One can control the brightness as well
as the color (color temperature) of the lamp by controlling the electrical current.
Tungsten-halogen lamps can be widely used in microscopy, especially when
acquiring color images.

Gas discharge lamps stimulate gas at the atomic level using strong electrical
fields. The excited atoms return to their initial state and, in doing so, give off the
energy which initially charged them in the form of electromagnetic radiation:
light. The resulting photons each have characteristic energy which is typical for
the gas being used. As a result, this type of lamp does not emit a broadband
spectrum like the halogen lamp, but instead emits discrete wavelengths. This
fundamental physical process cannot be externally influenced; hence, such a
lamp's perceived color is independent of the operation conditions. Because of
this discrete spectrum, gas discharge lamps do not emit a color-neutral illumi-
nation. Its adjustable high intensity light and the emission of short-wave spectral
bands required for fluorescent microscopy is an advantage.

Many microscopes can insert ND filters into the light path, thus reducing the
intensity of the lamp's light. These ND filters ensure a uniform reduction of light
intensity throughout the entire frequency range without altering the color
temperature.

s Kohler lllumination

Condenser

Note
9|

Principle of Kéhler
lllumination

This illumination process which was described by Dr. August Kohler as early as
1893, is still an indispensable prerequisite for successful analysis using light
microscopy. The Koéhler illumination enables an optimal, homogenous illumi-
nation of solely the part of the sample to be analyzed.

The condenser illuminates the sample. The main components are the aperture
stop with which the size of the illuminated area is set and the condenser lens
which is responsible for the parallel emitted light rays. The condenser can be
opened and closed. The condenser is height-adjustable and horizontally
adjustable.

Adjust the aperture stop so that it coincides with the aperture of the objective in
use. Do not use the aperture stop to modify the light intensity. To do that, you
should always use ND filters or a lower lamp voltage.

You will find comprehensive descriptions of the principle of Kéhler illumination in
microscopy text books. We will only give you a brief overview of some important
settings you should know.

Focussing the Field Diaphragm

One vital step when setting up the Kéhler illumination is the sharp view of the
field diaphragm at the specimen level.

1) Focus the object to be viewed.

2) Close the field diaphragm so that only a small bright spot is visible in the
eyepiece.



Adjusting the Lamp
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3) Focus the image in the field diaphragm by using the condenser's height
adjustment.

Adjusting the condenser

Now the illuminated area is optimally set.

1) Open the field diaphragm so that its edge is still completely within the visible
area.

2) Center the image of the field diaphragm using the condenser's adjustment
screws.
» A precisely adjusted condenser guarantees that only the area of the
specimen to be viewed is illuminated.

3) Open the field diaphragm, until the edge of the field diaphragm is no longer
visible in the visual field.

You can generally skip adjusting the lamp with modern microscopes, provided
that the lamp is located in a frame and the bulb is in a centered socket. When
you adjust the lamp, please turn to the corresponding manufacturer's
instructions for advice.

Objective, Total Magnification and
Useful Magnification

Terminology

Magnification

Numerical Aperture

Total magnification

There are no general rules for which objective you select; one should always
keep the specimen and reason for observation in mind.

The two most important parameters of an objective (magnification and numerical
aperture) are engraved in the objective. First the magnification and then the
numerical aperture which is separated by a diagonal slash. Hence, the code 40
/ 0.65 marks an objective with a magnification of 40x and the numerical aperture
of 0.65.

An objective's engraved magnification is considerably important for the total
magnification. However, one should note that the range of useful magnification
should not be surpassed.

The numerical aperture is the characteristic of an objective which determines its
capacity. The numerical aperture can also be found engraved on the objective.
It is based on the refraction index of the lenses being used as well as the
objective's angular aperture. The manufacturers are narrowly limited when
dealing with the refraction index, whereas the objective's angular aperture can
be increased by using appropriate measures. To achieve this, a fluid with a high
refraction index is placed between the cover slip and the objective. The
immersion objectives that can be used for this procedure are labeled
accordingly, they should only be used with the appropriate immersion fluid.

The system's total magnification, to which an installed TV adaptor contributes, is
based on the actual size of the final image. This can be the image on the monitor,
as well as the image printed on paper. To determine the total magnification, it is
best to use a stage micrometer which can be shown on the monitor or the
printout. You can determine the total magnification by dividing the length of the
object shown by the set length on the micrometer.

6€
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40

Useful
magnification

Empty
magnification

You can determine the total magnification by dividing the length of the object
shown by the set length on the micrometer. The useful magnification of the
optical systems microscope depends on the numerical aperture of the objective
being used (engraved on the objective). The useful magnification is in the range
of 500x to 1,000x the numerical aperture.

A loss of contrast and sharpness is the result if total magnification is larger than
the useful magnification. Check to see if replacing the TV adapter with a 0.5 or
0.63 model sufficiently reduces the total magnification. If this is not possible, you
can also use an objective with the same magnification, but with a higher
numerical aperture.
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Appendix II:
Installing the camera

Warning ﬁI

Please read the following carefully before attempting installation of
camera.

General Warnings

Warning

Warning

Warning

Warning

Warning

Warning

Warning

Warning

Warning

& |6 |&

& lele e |le |

CMOS image sensors are easily damaged by static discharge. Do not
disassemble the camera housing.

Do not attempt to touch the internals of the camera with your bare hands.

Do not touch cover slip (over the chip) with your hand or have any object come
into contact with glass surface. Should dust stick to the cover slip, blow it off
gently with an air blower. (For dust stuck due to static electricity, ionized air is
recommended.)

It is best to use a smooth brush to clean the cover slip. Do this only when
absolutely necessary.

Do not expose to strong light (sunlight) for long periods.

Exposure to high temperature or humidity will affect the characteristics of the
camera. Avoid storage or usage under such conditions.

Do not subject the camera to too much mechanical shock.

The USB plug is not symmetrical. You must make sure that the cable plug is
facing the same way as the camera socket when you plug the cable into the
camera jack.

Do not disconnect the USB cable while the image acquisition software is
running.

144
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Before the installation

The SC30 can be used with the operating systems Windows XP and Windows
Vista. The installation procedure for the camera will be described separately for
the Windows XP and the Windows Vista operating systems.

In order to avoid problems, you'll have to follow the steps of the procedure in the
order given here.

Warning @ | Install the software first, before connecting the camera to the PC.

1) Install the software on your PC.
2) Mount the camera onto your microscope.
3) Connect the camera to your PC and select the camera driver.

USB 2.0 interface

If you want to use the camera, you will need to have a USB 2.0 interface
available on your PC. If you are not sure whether a USB 2.0 interface is available
on your PC, open the Windows Device Manager via Start > Settings > Control
Panel > System > Hardware > Device Manager... .

Checking the interface

£ Device Manager

42

File  Action View Help

H & £ &

1y Mice and other pointing devices ~
% Monitors
HE Metwork adapters
5 Ports (COM & LPT)
ﬂ Processars
@, sound, video and game controllers
System devices

é Universal Serial Bus controllers

Aladdin HASP Key

Aladdin USE Key

IntellR) S2&01FE/FEM IUSE Universal Host Controller - 2655

InteliR) §2501FB/FEM USE Universal Host Controller - 2659
Intel{R) 52501FB{FEM IUSE Universal Host Controller - 2654
IntelR) 22801FB/FBM LISE Universal Hosk Controller - 2658
IntellR) S2801FE/FEM 1JSEZ Enhanced Host Contraoller - 265C )
LISE Root Hub
USE Root Hub
1USE Root Hub
USE Root Hub
USE Rook Hub

I e e e e e e

An entry with, e.g., the name 'Intel®82801FB/FBM USB2 ENHANCED HOST
CONTROLLER' in the USB Controller area indicates that the required interface
is available.
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USB Controller on a board

Should your PC's USB controller not be on the motherboard, but is built in on a
separate board, no guarantee can be made that the camera can be used without
any problems. The Device Manager dialog box provides no information as to
whether the interface is available on the computer's motherboard. Please either
check this out in the computer's manual, or ask your system administrator for
help.

ey
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Installing the camera with Windows XP

SC20
SC30
XM10
XC10
uC30
XC30
UCs0
XC50

Warning ﬁI

The following step-by-step instructions describe the installation procedure for the
getlT software under the Microsoft Windows XP operating system. These
instructions apply for the following Olympus light microscopy cameras:

SC20, SC30, XM10, XC10, UC30, XC30, UC50, XC50.

Installing the image acquisition software getIT

Install the image acquisition software before connecting your camera to your PC.
This is necessary so that the operating system does not install the wrong TWAIN
camera driver.

1) Place the CD that has been supplied into the CD-ROM drive.
» The installation program will start automatically - unless you have
deactivated the autorun function. If so, please start the setup.exe file
manually.

analySIS getIT Setup (Build 1633) 53
Welcome to the analy515 getlT Wizard

Thiz "Wizard inztallz analyS15 getl T on your Computer.
Press Mest' to continue.

Mest > | Cancel

2) Click the Next > button.
» The following dialog box opens.
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analySIS getIT Setup (Build 1633) |

analy515 getlT Language Selection g

Select one of the following languages:

* Englizh
" German

" French

< Back Mest > | Cancel |

3) Select the language of your getlT software. The default language is your
operating system's language.
Click the Next > button.
» The Select Twain Driver dialog box opens.

114

analySIS getIT Setup (Build 1633) |

Select Twain Driver g

analySIS getlT installs a T'wAIM driver for the selected cameralz). You may then alzo uze the
cameralz] within other applications via the TWAIN interface. Select the Twain drivers you want
ta install:

M SCa0
[ Olympus Soft Imaging S olutions Firewire Cameras

Select4l | Claral |

< Back Mest > | Cancel |

4) Select the TWAIN driver for your camera.
Please note: a special driver is required for the SC20 and the SC30
cameras. Select the SC20, resp. SC30, check box.
Select the Olympus Soft Imaging Solutions Firewire Cameras check box
with all the other cameras (XM10, XC10, UC30, XC30, UC50, XC50).

5) Click the Next > button.
» The Choose Destination Location dialog box opens.
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analySIS getIT Setup (Build 1633)

Choose Destination Location
Select folder where Setup will install files.

Setup will install analyS1S getl T in the following folder.

Ta install to this folder, click Mext. To install to a different folder, click Browse and select
another folder.

Destination Folder

C:\Program FileshanalyS15 getl T Browse...

< Back Mest > | Cancel |

6) If you want to change the directory on which the getlT image acquisition
software is to be installed, click the Browse... button. Select the desired
directory.

7) Click the Next > button.

» The Choose Folder dialog box opens.

46

analySIS getIT Setup (Build 1633)

Select Program Folder
Select the location where setup is to create new shortcuts.

Setup will add program shortcuts to the Program Folder listed below. You may type a new folder
hame, or select one from the Existing Folders list. Click Next to continue.

Program Folder:

Existing Folders:

Administrative Tools
Catalyst Control Center
Games
Startup

< Back Mest > | Cancel

8) Select the installation folder. You can either browse to an existing folder or
create a new one.

9) Click the Next > button.

» The getIT software manual is available as a PDF file. In the next dialog
box you decide whether the Acrobat Reader program should be
installed automatically together with the getlT image acquisition
software.
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analySIS getIT Setup (Build 1633) |

Install Acrobat Reader g

The Adobe Reader iz recommended for use with the analpS15 getl T documentation. [f you do
not already have the Adobe Reader, vou may now install it along with analyS15 getlT.
‘wiould you like to install the Adobe Reader?

" Yes, install it

* Ma, da not install it

< Back Mest > | Cancel |

10) Select the Yes, install it option if you want to automatically install the
Acrobat Reader program. You'll need this program in order to read the getIT
software manual.

Select the No, do not install it option for instance if the Acrobat Reader

program is already installed. N
11) To start the actual installation, click the Next > button. ~
12) Wait until the following dialog box opens.

analySIS getIT Setup (Build 1633)

analy515 getlT Wizard completed

Setup has finished instaling analpS15 getl T on your computer.

Firish | |

13) Click the Finish button to finalize the installation.
» The getlT image acquisition software has now been installed.
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Mounting the camera

Warning Install the image acquisition software before connecting your camera to your PC.
<§> | This is necessary so that the operating system does not install the wrong TWAIN
camera driver.

The diagram shows a typical installation on a light microscope. You should have
all of the required components ready at hand.

USB connecting cable

' <— Camera

<«—— C-Mount Adapter

PC with image acquisition software
and USB 2.0 interface

q L = -. -
\ .
‘\‘II i . -

USB 2.0 plug

48

1) Remove the protective cap from the camera.

2) Firmly screw the TV adaptor and the C-Mount (0.5x or bigger") onto the
camera. This should be done with the microscope mount facing down to
minimize the chance of dust landing on its surface.

3) Install this assembly onto the microscope's camera mount. Some micro-
scopes may require additional optical elements installed between the
camera mount and the C-mount adapter. You may also need to align the
orientation of the microscope with that of the stage, and also match the
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focus of the camera image with that of the eyepiece image. These settings
can be done later when you are able to obtain an image on the screen.

4) Plug the end of the camera's USB 2.0 cable into a free socket of your PC.
Should more than one USB slot be available, you can make an arbitrary

choice of which jack you use.

5) Continue with the camera driver registration before starting your software.

Selecting the camera driver

» After connecting the camera to your PC, the Found New Hardware

Wizard will automatically start.

Registering the camera driver

The camera driver is automatically installed when setting up your image acqui-
sition software. The camera driver is not signed and therefore will not be used
automatically by Windows XP. After having installed the image acquisition
software and having connected the camera to the computer, you must register

the camera driver with Windows XP.

1) Windows XP opens the Found New Hardware Wizard dialog box.

Found New Hardware Wizard

Hardware Wizard

Eead our privacy policy

software?

() e, this time anly

() No, not this time

Click Mest to continue.

Welcome to the Found New

Wwindows will zearch for curmrent and updated software by
looking on your computer, on the hardware installation CO, or on
the "Windows Update “Web site [with pour permizzion).

Can ‘Windows connect to Windows Update ta search for

() Yes, now and every time | connect a device

6V

l

Mext > ][ Cancel ]

2) Select the No, not this time option and click the Next > button.
» An additional Found New Hardware Wizard dialog box opens.
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Found New Hardware Wizard

Thiz wizard helpz you install software for:

Olympus Soft Imaging Solutions USE 2.0 Camera Driver

f:') If your hardware came with an installation CD
“4E2 or Hoppy disk. insert it now.

‘what do you want the wizard to do?

(® Install the software sutomatically [Fecommended)
(O Install fram a list ar specific location (Advanced)

Click Mest to continue.

[ < Back " Mext > ][ Cancel ]

3) Insert the image acquisition software CD and select the Install the software
automatically (Recommended) option and click the Next > button.
» The installation begins. After a little while, the Hardware Installation
dialog box will pop up.

Hardware Installation

] E The software you are installing for thiz hardware:
L

50

Olympus Soft Imaging Solutions USE 2.0 Camera Driver

hasz not pazzed Windows Logo testing to verify its compatibility

with *Windows %P, [Tell me why this testing iz important. )

Continuing your i llation of this sof may impair
or destabilize the t tion of your system
either immediately or in the future. Microsoft strongly
recommends that you stop this installation now and

tact the hard: vendor for sof that has
passed Windows Logo testing.

[ Continue Angway ] [ STOP Installation

4) Click the Continue Anyway button.
» An additional Found New Hardware Wizard dialog box opens.
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Found New Hardware Wizard

Completing the Found New
Hardware Wizard
The wizard has finizhed installing the software for:

Qlyrpus Soft Imaging Solutions USE 2.0 Camera
Drriver

Click. Finish to cloze the wizard.

5) Click the Finish button.
» In doing so, the registration of your camera driver with Windows XP is
not yet finished. Windows XP opens the Found New Hardware Wizard =
dialog box a second time.

6) Repeat steps 2 to 5.
» In doing so, the registration of your camera driver with Windows XP is

finished.
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Installing the camera with Windows Vista

SC20
SC30
XM10
XC10
uC30
XC30
UCs0
XC50

Warning ﬁI

52

The following step-by-step instructions describe the installation procedure for the
getlT software under the Microsoft Windows Vista operating system. These
instructions apply for the following Olympus light microscopy cameras:

SC20, SC30, XM10, XC10, UC30, XC30, UC50, XC50.

Installing the image acquisition software getIT

Install the image acquisition software before connecting your camera to your PC.
This is necessary so that the operating system does not install the wrong TWAIN
camera driver.

1) Place the CD that has been supplied into the CD-ROM drive.
» The installation program will start automatically - unless you have
deactivated the autorun function. If so, please start the setup.exe file
manually.

2) If Microsoft Windows Vista opens the Open File - Security Warning dialog
box, click the Run button.
» Microsoft Windows Vista will automatically switch to the Security
Desktop.

User Account Control &J

'@ An unidentified program wants access to your computer

Don't run the program unless you know where it's frem or you've used it
before.
~El setup.exe

L Unidentified Publisher

< Cancel

I don't know where this program is from or what it's for.

< Allow
Ttrust this program. I know where it's from or I've used it before.

W | Details

User Account Control helps stop unauthorized changes to your computer.

3) Click the Allow entry to start the installation.
» Before the installation can be started you will possibly have to prove
your authorization.



=
9

.L_'\

Please enter credentials for a user that can access this
resource

User name: L ] - |
Password:

Cannot access network resource lilg

4) Enter your MS-Windows user name and your password and confirm them

with OK.

» The installation of the getlT image acquisition software will be prepared.
» The following dialog box opens.

analySIS getlT Setup (Build

analy515 getlT Language Selection

Appendix II: Installing the camera

W

Select one of the following languages:

@ English
" Geman
i French

IristallS higld

< Back Next > I

Cancel |

5) Select the language of your getIT software. The default language is your

operating system's language.
Click the Next > button.

» The Select Twain Driver dialog box opens.

€g
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analySIS getlT Setup (Build 11

Select Twain Driver g

analys|5 getlT installs a TWwWAIN driver for the selected camerals). Yiou may then alwo uze the
camera(s] within other applications via the TWAIN interface. Select the Twain divers you want
toirestall:

Clear Al

< Back Next > | Cancel |

6) Select the TWAIN driver for your camera.
Please note: a special driver is required for the SC20 and the SC30
cameras. Select the SC20, resp. SC30, check box.
Select the Olympus Soft Imaging Solutions Firewire Cameras check box
with all the other cameras (XM10, XC10, UC30, XC30, UC50, XC50).
» The Choose Destination Location dialog box opens.

analySIS getlT Setup (Build 11

Choose Destination Location
Select folder where Setup will install files,

Setup will install analySIS getlT in the following folder.

54

Tainstall to this folder, click Newt. To install to a different falder, click Browse and select
another folder.

Destination Folder

C:\Program FileshanalySI1S getl T Browse...

< Back Next > | Cancel |

7) If you want to change the directory on which the getlT image acquisition
software is to be installed, click the Browse... button. Select the desired
directory.

8) Click the Next > button.
» The Choose Folder dialog box opens.
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analySIS getlT Setup (Build 16

Select Program Folder
Select the location where setup is to create new shartcuts.

Setup will add pragram shortcuts to the Program Folder listed below. You may tppe a new folder
name, o select one from the Existing Folders list. Click Next to continue.

Program Folder.

Adrministrative Tools
Catalyst Control Center
Estras and Upagrades

< Back Next > | Cancel |

9) Select the installation folder. You can either browse to an existing folder or
create a new one.

10) Click the Next > button.
» The getlT software manual is available as a PDF file. In the next dialog

box you decide whether the Acrobat Reader program should be

installed automatically together with the getlT image acquisition
software.

analySIS getlT Setup (Build 16

Install Acrobat Reader g

The Adobe Reader is recommended for use with the analySIS getiT documentation. [f pou do
not already have the Adobe Reader, you may now install it along with analyS15 getl T
“Would you like to install the Adobe Reader?

" Ve, install it

< Back Nest > | Cancel |

11) Select the Yes, install it option if you want to automatically install the
Acrobat Reader program. You'll need this program in order to read the getIT
software manual.

Select the No, do not install it option for instance if the Acrobat Reader
program is already installed.

12) To start the actual installation, click the Next > button.

GS
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Warning ﬁI

13) Wait until the following dialog box opens.

analy515 getT Wizard completed

Setup has finished inztaling analyS1S getlT an your computer.

Finish |

14) Click the Finish button to finalize the installation.
» The getlT image acquisition software has now been installed.

Mounting the camera

Install the image acquisition software before connecting your camera to your PC.
This is necessary so that the operating system does not install the wrong TWAIN
camera driver.

The diagram shows a typical installation on a light microscope. You should have
all of the required components ready at hand.
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USB connecting cable

O <«— Camera

<«—— C-Mount Adapter

PC with image acquisition software
and USB 2.0 interface

. L — -. - ﬂ
\ :
\-. i

USB 2.0 plug

1) Remove the protective cap from the camera.

2) Firmly screw the TV adaptor and the C-Mount (0.5x or bigger") onto the
camera. This should be done with the microscope mount facing down to
minimize the chance of dust landing on its surface.

3) Install this assembly onto the microscope's camera mount. Some micro-
scopes may require additional optical elements installed between the
camera mount and the C-mount adapter. You may also need to align the
orientation of the microscope with that of the stage, and also match the
focus of the camera image with that of the eyepiece image. These settings
can be done later when you are able to obtain an image on the screen.

4) Plug the end of the camera's USB 2.0 cable into a free socket of your PC.
Should more than one USB slot be available, you can make an arbitrary
choice of which jack you use.

5) Continue with the camera driver registration before starting your software.
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Selecting the camera driver

» After connecting the camera to your PC, the Found New Hardware
Wizard will automatically start.

| Windows needs to install driver software for your Unknown
Device

Windows will guide you through the process of installing driver softw
for your device,

@ Locate and install driver software (recommended) )
are

¥ Ask me again later
Windows will ask again the next time you plug in your device or log on,

® Don't show this message again for this device
Your device will not function until you install driver software.

Cancel

1) Click the Locate and install driver software (recommended) entry.
» Microsoft Windows Vista will then ask to be allowed to activate the
device driver.

2) Confirm the message by clicking the Continue button.
3) Wait until Microsoft Windows Vista has opened the displayed security
query.

I @] Windows can't verify the publisher of this driver software

58

% Don'tinstall this driver software
You should check your manufacturer's website for updated driver software
for your device.

<+ Install this driver software anyway
Only install driver software obtained from your manufacturer's website or
disc. Unsigned software from other sources may harm your computer or steal
information.

(v) See details

4) Click the Install this driver software anyway entry.
» Your camera is now ready for use.

5) Start the getlT image acquisition software or any application program that
supports TWAIN.

Your camera is now registered as a TWAIN device and can be selected.
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Appendix IlI:
In case of problems with the
camera...

Most problems with the SC30 camera are due to the PC's USB system. Should
a problem crop up, please check the following points before you turn to our
customer service.
® Isthere an Intel®82801FB/FBM USB2 ENHANCED HOST CONTROLLER
in your PC?
* Have you connected an extension cable to the SC30's cable?

» Remove the extension cable, since in this case the required data rate
might not be achieved.

* Are additional USB devices connected to the USB controller?

» Remove these devices, since in this case the required data rate might
not be achieved. Should the problem have been solved in this manner,
you can then reconnect the other devices by using a separate USB
controller board plugged into a PCI slot.

* Does your PC have an activated Intel Hyper Thread Function in the BIOS?

» Deactivate this function.

Should you have questions or should problems arise which you cannot solve
with the help of the documentation provided, please feel free to contact our
customer service - preferably via e-mail. Our customer-service personnel will be
more than happy to assist you.

1) Please clarify before hand when and under what circumstances the
problem arose.
* It would be best if you can clearly reproduce the problem/error. You will
therefore make it easier for you and our customer-service personnel to
solve the problem.

2) Please write down the exact wording of the (error) messages which appear.
* As an alternative, you can make screenshots of these messages. You
can make a screen shot of your active window by using the key combi-
nation [Alt+Print]. A copy of the active window is stored to your clipboard

and can be easily attached to an e-mail using [Ctrl+V].

* Since very large e-mails can create transmission problems both for the
sender and the receiver, do not copy "screenshots" of the entire
contents of the screen. For the same reasons it is advisable to reduce
the color depth of the screenshots.

3) Should the camera basically work, but problems with image quality arise,
save an image in which the problems are clearly visible in TIF format. Insert
this example image in your e-mail to our customer service.

4) Start the software.
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BE

5) Use the ? > About... command to open the About dialog box.

>

The About dialog box shows you information about the software
package (Docu, Auto, Pro), the build number and the serial number of
your software as well as the operating system being used.

The software data mentioned should be at hand when you contact our
customer service personnel.

6) Please write an e-mail clearly describing the problem (including screen-
shots and example images), as well as the software data from the About
dialog box, to our customer service address.

support@olympus-sis.com

The quickest and most convenient way is to use the automatic e-mail
settings for your customer service query:

Viathe ? > About... > System Info... > Send button, an automatic e-mail
is created which you can then complete and send to us. If you have
made an example in TIF format, please attach this to the e-mail as well.
Before you send a malil, please read the notes in your e-mail window
about the data that you're sending us in this e-mail.

Should you not be able to send e-mails from your PC, use the ? >
About... > System Info... > Save Info button to save the files and to send
them from another computer.

You may, of course, also contact us via telephone or fax:

Tel.: (+ 49) 251 /7 98 00-6444

Fax: (+ 49) 2 51 /7 98 00-6445.



Appendix IV: WEEE declaration

Appendix IV:
WEEE declaration

In accordance with European Directive 2002/96/EC on Waste Electrical and
Electronic Equipment, this symbol indicates that the product must not be
disposed of as unsorted municipal waste, but should be collected separately.

Refer to your local distributor for return.

Waste Electrical
and Electronic
Equipment

T9
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Appendix V:
EMC declaration - SC30

OLYMPUS

———— T E—

Your Vision, Our Future

Declaration of Conformity E M C

Product Type CMOS Camera

Brand Name Olympus

Model Designation 8C30

Manufacturer Olympus Soft Imaging Solutions GmbH
Johann-Krane-Weg 38
48148 Minster
Germany

The product complies with the requirements of the following European directives:

2004/108/EC Directive of the European Parliament and of the Council
of 15 December 2004 on the approximation of the laws of the
Member States relating to electromagnetic compatibility and repealing
Directive 88/336/EEC.

Compliance was proved by the application of the following
electromagnetic compatibllity standards
EN §1328:1997 + A1:1998 + A2:2000 + A3:2003

FCC Code of Federal Regulations, CFR47, Part 15 Sections 15.107 and 15.109 (Class B)
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Appendix VI.
RoHS declaration - SC30

OLYMPUS

Your Yision, QOur Future

Declaration of Conformity Ro H S
Product Type CMOS Camera
Brand Name Olympus.
Model| Designation SC30
Manufacturer Clympus Soft Imaging Solutions GmbH

Johann-Krane-Weg 38

48148 Minster

Germany

€9

The product complies with the requirements of the following RoHS directives:

2002/36/EG Directive of the European Union on the restriction of the use of certain
hazardous substances in electrical and alectronic aquipment (ReHS)

ACPEIP Administration on the Confrol of the Pollution caused by Electronic
Information Products (China RoHS)

and the related standards

SJIT 11363 - 2006
ST 11364 - 2006
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Index

B
Brightness 18

C

Calibration

Apply 23

Define 20
Camera driver 7
Camera, Select 14
Color settings 17

Gamma Correction 18
Color temperature of the monitor 9
Contrast 18

Optimize 18
Correcting color errors 17

E

Exposure time 16
Automatic 17

G

Gamma Correction 18

Image
Acquire 16
Calibrate 23
Delete 34
Load 27
Print 29
Save 24
Image acquisition 16
Step by Step instruction 13
Image buffer 10
Image buffer box 10
Hide 34

Image display
Optimize 12
Single view, Tile view 12
Image information 25
Image name 25, 26
Image window 10
Input, Set 14
Installation of software and camera driver 7

K

Kdhler illumination, microscope 38

L

Live image 16

M

Microscope 37
Controlling illumination intensity 8
Empty magnification 40
lllumination 37
Numerical Aperture 39
Objective 39
Total magnification 39
Useful magnification 39, 40
Microscope Illlumination Intensity 8
Microscope settings 8, 37
Monitor Settings 9

P

PC, Requirements 6
Print 31

Print directly 29

Single image, Multiple images 31
Print setup 30



R

Resolution 16

S

Saturation 18
Save 24
Scale bar
Burn into image 33
Show in viewport 33
Scan 19
Serial Number 60
Sharpen filter 18
Special 9
System Info 35, 60
System requirements 6

T

Total magnification, microscope 8

TWAIN dialog box 16
TWAIN interface 13

U

Useful magnification, Microscope 40

User Interface 10

Vv
Viewport 10

w

White Balance 8, 17
Execute 9

Z

Zoom factor 10

Index

g9



OLYMPUS

OLYMPUS SOFT IMAGING SOLUTIONS GMBH

Johann-Krane-Weg 39, 48149 Miinster, Germany
Phone: +49 (251) 7 98 00-0, Fax: +49 (251) 7 98 00-6060, info.osis@olympus-sis.com

OLYMPUS SOFT IMAGING SOLUTIONS CORP.

200 Union Blvd, Suite 202, Lakewood, CO 80228, U.S.A.
Phone: +1 (303) 234-9270, Fax: +1 (303) 234-9271, info.osis@olympus-sis.com

OLYMPUS SOFT IMAGING SOLUTIONS PTE. LTD.

No 2 Jurong East St 21 #05-30, IMM Building, Singapore 609601
Phone: +65 (6777) 7898, Fax: +65 (6777) 7218, info.osis@olympus-sis.com

www.olympus-sis.com
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